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Create Worksheet Formulas



Excel Formulas
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Excel formulas perform simple or complex mathematical computations in worksheets. You 
can use formulas to perform tasks such as adding up a row or a column of numbers, 
multiplying sales figures by commission rates, and applying tax to sales. One of the key 
benefits of using formulas in Excel is that you can change some of the values used in the 
formulas and, by default, Excel will automatically adjust the calculations accordingly.

Excel can perform calculations by using fixed numbers, or by referring to values in other 
cells. This is one of the truly powerful features of using Excel to perform calculations. Excel 
2021 provides you with an incredible array of options for performing calculations in your 
workbooks and worksheets.



The Formula Bar
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Formula Bar Option Description

Cancel button

The Cancel button is displayed only when a cell is in Edit mode or Enter mode. 
Selecting the Cancel button will undo any changes you have made to a cell since 
selecting it and will keep that cell active. Basically, it reverts the cell back to its 
state before you began editing it. 

Enter button
The Enter button is essentially the same as pressing Ctrl+Enter. When you select 
the Enter button, Excel enters whatever content is in the active cell and keeps 
the cell active. 

Insert Function button The Insert Function button opens the Insert Function dialog box, providing you 
with access to a wide variety of pre-existing Ex



Excel Formula Element Description

Equal sign
The equal sign defines cell content as a formula. The equal sign tells Excel to perform a 
calculation based on the formula components and then to display the result of the 
calculation in the cell. All formulas in Excel must start with an equal sign.

Constants Numbers and text that do not change unless manually altered. 

References Essentially, the variables in Excel formulas. When you include a reference to a cell or a 
range, Excel uses the value(s) from that cell or range to perform the calculation.

Mathematical operators Symbols that specify the kind of calculation that Excel should perform on the elements of 
a formula.

Elements of Excel Formulas
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Common Mathematical Operators
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Excel uses a set of the most commonly used mathematical operators to perform a wide 
variety of calculations. These are simply symbols Excel uses to identify the calculations it 
should perform.

Mathematical Operator Symbol Function/Operation

Parentheses ( )
Groups a set of constants, 
references, and operators into a 
single value within a formula.

Caret ^ Exponentiation
Asterisk * Multiplication
Forward slash / Division
Plus sign + Addition
Minus sign - Subtraction



The Order of Operations
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Excel gives precedence to certain mathematical operators over others. This is how Excel 
determines which operation to perform first, second, third, and so on in a complex 
formula. It is important that you understand how Excel will compute a formula before you 
create one to ensure that Excel will perform the calculation exactly as you want it to. The 
following is the order of operations, from first to last:

• Parentheses
• Exponents
• Multiplication and division
• Addition and subtraction

While often used for subtraction, the minus sign ( 
– ) can also be used to denote a negative value. In 
these cases, the minus sign takes greater 
precedence than exponents, allowing you to 
calculate the exponential value of a negative 
number. Percentage signs ( % ) also take higher 
precedence than exponents.



Reference Operator Symbol Function

Comma ,

The comma is used as a union operator, which tells Excel to include each reference 
in a series of references. This is similar to how you would use a comma when 
writing a serial list; you are telling Excel to include each of the references. So, 
A1,B3,C5 tells Excel to include the values in each of these three cells.

Colon :

The colon is used as a range operator, which you've already seen when selecting a 
range of cells. The colon tells Excel to include all cells in a range between the cell 
references on either side of the colon. For example, A1:A10 tells Excel to include 
the values in every cell from A1 to cell A10.

Space N/A

A blank space is an intersection operator. This tells Excel to look for a value in the 
cell where two ranges intersect. For example, A9:J9 E2:E22 tells Excel to look for 
the value in the cell where these two ranges intersect, which in this case would be 
the value in cell E9. If you have a spreadsheet of salespeople as the rows and their 
quarterly sales as the columns, you can use an intersection to find how well 
Salesperson X did in Q3. Although you might be able to find this information by 
simply looking at the spreadsheet, this can become a hassle in larger spreadsheets 
that require scrolling through multiple pages.

Reference Operators
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Presenter
Presentation Notes
Mathematical operators aren't the only type of operators you will use to work with the data in your workbooks. In fact, there are four different kinds of operators you can use to perform calculations. Reference operators are one of the most important. Reference operators tell Excel which cell or range values to use as variables in your formulas. There are three reference operators: the comma, the colon, and the space.




Reference Operators
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Excel reads a blank space only as an intersection operator if no other operator is present 
between cell or range references. If you enter another reference operator between the 
cell or range references, Excel will read the operator and ignore the spaces. So, A1:A3, A5, 
A6 is the same, to Excel, as A1:A3,A5,A6. Here, the spaces don't matter because of the 
commas. Excel will not look for the intersection, which in this case makes sense as the 
cells don't actually intersect.
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Insert Functions



Functions
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In Excel, functions are simply built-in, predefined formulas that you can quickly and easily 
insert into worksheet cells. Like formulas, all functions begin with an equal sign. Unlike 
formulas, in functions the equal sign is followed by the function name and then a set of 
arguments in parentheses, which are separated by commas. Arguments can be cell 
references, constants, formulas, or even other functions or logical values. Functions use 
their arguments in specific ways to calculate a result. The function name is typically the 
name, or an abbreviated version, of the actual mathematical function.



The Function Library Group
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Category Provides You with Access To

Recently Used The functions you have most recently used. When you first install Excel, you can access a set of commonly 
used functions from this menu.

Financial Functions used to perform business calculations, such as determining loan repayment figures, determining 
the future value or net present value of an investment, and calculating asset depreciation.

Logical Functions that determine if an argument is true or false, or if it meets other logical conditions. 

Text Functions that change text values, such as making text all capital letters or converting numbers into dollar 
amounts.

Date & Time Functions that allow you to incorporate dates and times into calculations. You might use these, for example, 
to determine how many work days occur between two specific dates. 

Lookup & 
Reference

Functions that allow you to look up a particular cell value or reference from a range or table given specific 
criteria.

Math & Trig Formulas that perform a number of different mathematical or trigonometric calculations.

More Functions A set of menus that contain some higher-level and less commonly used functions, such as engineering and 
statistical functions.

Presenter
Presentation Notes
Excel 2021 provides you with a central location for accessing all of its available functions. The Function Library group contains a set of menus that organize Excel functions according to specific categories for ease of reference. It also provides you with access to the Insert Function button, which is the same as the one on the Formula Bar, and the AutoSum feature. You can access the Function Library group on the Formulas tab.




The Insert Function Dialog Box
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Insert Function Dialog 
Box Element Use This To

Search for a function 
field

Enter a description of what you would like a function to do. For 
example, you could type "add numbers together" or "find the 
average of a set of numbers." The Insert Function dialog box 
will use this as a search query to find the appropriate function.

Go button Execute a function search.

Or select a category 
drop-down list

Filter the available functions by category. If you perform a 
search, this list defaults to the Recommended setting and the 
search results will appear in the Select a function list. Even if 
you've entered a search query, if you change the setting here to 
any category other than Recommended, the Select a function 
list displays all functions in the selected category, effectively 
ignoring the search query.

Select a function list
View a list of available functions depending on your search 
query or your selection in the Or select a category drop-down 
list.

Function description View a brief description of the currently selected function.

Help on this function 
link

Open the Excel 2021 Help window to display an article about 
the currently selected function.

Presenter
Presentation Notes
The Insert Function dialog box enables you to search for and insert into cells any of the available functions in Excel 2021. It also displays a brief description of whatever function you have selected and provides a link to open the Excel 2021 Help window, which automatically displays help content on the currently selected function. You can access the dialog box by selecting the Insert Function button either on the Formula Bar or in the Function Library group.



The Function Arguments Dialog Box
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Function Arguments Dialog Box Element Use This To

Required argument fields Enter the required arguments for the function. The required argument names appear in bold 
text.

Optional argument fields Enter the desired optional arguments for the function. The optional argument names appear 
in non-bold text.

Collapse Dialog button

Minimize the Function Arguments dialog box to graphically select cell and range references 
directly on your worksheets. This command appears in numerous dialog boxes, wherever you 
have the option of manually selecting a cell or range. Once you collapse a dialog box, this 
becomes the Expand Dialog button, which you can use to restore the dialog box to its full size.

Function description View a brief description of the function.

Argument description View a brief description of the currently selected argument.

Presenter
Presentation Notes
The Insert Function dialog box enables you to search for and insert into cells any of the available functions in Excel 2021. It also displays a brief description of whatever function you have selected and provides a link to open the Excel 2021 Help window, which automatically displays help content on the currently selected function. You can access the dialog box by selecting the Insert Function button either on the Formula Bar or in the Function Library group.



Graphical Cell and Range Reference Entry
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Excel 2021 provides you with a useful graphical method for entering cell and range 
references for a number of purposes, including for use in formulas and functions. 
Whenever you need to enter a cell or range reference, you have the option of typing the 
reference manually or selecting the reference graphically right from the worksheet. This is 
why the Function Arguments dialog box provides the Collapse Dialog buttons.   These 
minimize the dialog box, providing you with easier access to your worksheets for the 
purpose of graphically selecting references. To graphically select a reference, you can 
simply select the cell or the range with mouse clicks or by dragging the mouse (or by 
using the appropriate equivalent action on a touchscreen device), and then either press 
the Enter key or select the Expand Dialog button  in the minimized dialog box.

Presenter
Presentation Notes
If you are manually typing a formula or function, once you've graphically selected a range, you can simply enter the next formula element or type a comma and then enter the next function argument.



The AutoSum Feature
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The AutoSum feature will automatically try to guess which cells you would like to add 
together if you use it on a cell in a row or a column that contains values. AutoSum first 
looks for cells above, then looks for cells to the left of the active cell.

You can also manually edit the group of cells or the range that the AutoSum feature 
should include as arguments in the SUM function. If there are no values in the row and 
the column associated with a cell and you insert the SUM function, you must manually 
enter the arguments in the SUM function

You can access the AutoSum feature by selecting Formulas → AutoSum or by using the 
Alt+= keyboard shortcut. For ease of access purposes, Excel also displays the AutoSum 
button in the Editing group on the Home tab.

Presenter
Presentation Notes
You do not have to use the AutoSum feature to insert a SUM function. You can also simply type the SUM function into a cell or access the SUM function from the Math & Trig menu in the Function Library group.



Other Commonly Used Functions
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The AutoSum button also provides you with quick access to some other commonly used 
Excel functions. When you select the drop-down arrow, Excel displays a menu that allows 
you to insert one of these other common functions into the active cell.

Function Use To

SUM Add the values entered in the cells that are specified in the arguments.

AVERAGE Calculate the average of the values entered in the cells specified in the 
arguments.

COUNT Find the number of cells, out of those that have been specified in the 
arguments, that contain numeric entries.

MAX Find the largest single numeric value out of all of the values entered in 
the cells specified in the arguments.

MIN Find the smallest single numeric value out of all of the values entered 
in the cells specified in the arguments.

Similar functions to COUNT include COUNTA, which finds the number of cells that contain any type of 
value, and COUNTBLANK, which finds the number of cells that contain no value at all.



Basic Function Syntax
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A function's syntax is simply the structure necessary to 
properly express the function and to define its arguments. 
The function name is followed by a set of parentheses that 
contains the function's arguments; the arguments are 
separated by commas. 

Remember that depending on the particular function you 
are using, arguments can include constants, cell or range 
references, logical values such as TRUE or FALSE, formulas, 
and even other functions.

• Functions can contain both required and optional arguments. In function syntax, optional arguments are  
notated by using square brackets [ ].

• Each function has a unique syntax and requires different specific arguments. If all of the arguments for a 
function are valid, the function will return a result in a cell. If one or more of the arguments in a function 
are invalid, Excel will return an error, which you will have to correct.



The SUM Function
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Syntax: =SUM(number 1, [number 2], ...)

Description: Adds the values specified by the arguments. For this function, the arguments 
can be constants, cell or range references, or both.

To Add These Numbers Enter This Function

The values in cells A1 through A10 =SUM(A1:A10)

The values in cells A1 through A10, in cell B3, 
and in cell D17 =SUM(A1:A10, B3, D17)

The values in cells A1 through A10, in cell B3, in 
cell D17, and the numbers 14 and 7 =SUM(A1:A10, B3, D17, 14, 7)



To Find the Average of These Numbers Enter This Function

The values in cells A1 through A10 =AVERAGE(A1:A10)

The values in cells A1 through A10, in cell B3, and 
in cell D17 =AVERAGE(A1:A10, B3, D17)

The values in cells A1 through A10, in cell B3, in 
cell D17, and the numbers 14 and 7 =AVERAGE(A1:A10, B3, D17, 14, 7)

The AVERAGE Function
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Syntax: =AVERAGE(number 1, [number 2], ...)

Description: Adds the values specified by the arguments and then divides the total by the 
number of individual values. In other words, the AVERAGE function calculates the average 
(arithmetic mean) of the specified values. For this function, the arguments can be 
constants, cell or range references, or both.



To Count the Number of Numeric Entries in 
These Cells Enter This Function

A1 through A10 =COUNT(A1:A10)

A1 through A10, B7, and F11 =COUNT(A1:A10, B7, F11)

All cells from A1 through D10 =COUNT(A1:D10)

The COUNT Function
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Syntax: =COUNT(value 1, [value 2], ...)

Description: Counts the number of cells specified in the arguments that contain a numeric 
entry. For this function, the arguments can be cell or range references, or both.



To Return the Largest Numeric Value from These 
Sources Enter This Function

The values in cells A1 through A10 =MAX(A1:A10)

The values in cells A1 through A10, B13, and 
C22 =MAX(A1:A10, B13, C22)

The values in cells A1 through A10, and the 
number 78 =MAX(A1:A10, 78)

The MAX Function
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Syntax: =MAX(number 1, [number 2], ...)

Description: Returns the largest numeric value out of all numeric values in the arguments. 
For this function, the arguments can be constants, cell or range references, or both.



To Return the Smallest Numeric Value from 
These Sources Enter This Function

The values in cells A1 through A10 =MIN(A1:A10)

The values in cells A1 through A10, B13, and 
C22 =MIN(A1:A10, B13, C22)

The values in cells A1 through A10, and the 
number 78 =MIN(A1:A10, 78) 

The MIN Function
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Syntax: =MIN(number 1, [number 2], ...)

Description: Returns the smallest numeric value out of all numeric values in the 
arguments. For this function, the arguments can be constants, cell or range references, or 
both.



The Formula AutoComplete Feature 
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• The Formula AutoComplete feature is a 
dynamic feature that anticipates the 
function you want to use in a cell.

• The Formula AutoComplete feature 
also displays a tooltip that describes 
whatever function you select from the 
pop-up menu.

• The Formula AutoComplete feature also provides 
you with assistance when entering function 
arguments. As you enter the arguments for the 
selected formula, Excel displays a different tooltip 
that highlights the specific argument you're 
currently entering
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Reuse Formulas and Functions



The Paste Options
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Excel 2021 provides you with a number of different options for pasting copied content 
into other cells. This is because there will be occasions where you want to paste certain 
elements of a cell's content into another cell, but not the exact contents.

When you copy a cell's contents to the 
clipboard, a number of paste options become 
available that you can access from the Paste 
drop-down arrow in the Clipboard group. These 
options are also available from the Paste 
Options button if you paste the content by using 
the Paste button or the Ctrl + V keyboard 
shortcut.

The paste options are not available if you cut a cell's content. They are available only 
when you copy and paste.



The Paste Options
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Paste Option Will Paste
Paste All of the copied cells' contents.
Formulas Just the formulas from the copied cells. 
Formulas & Number Formatting The formulas and any applied number formatting from the copied cells.
Keep Source Formatting All of the copied cells' content along with all applied formatting.
No Borders All of the copied cells' content and formatting except for the border formatting.

Keep Source Column Widths All of the copied cells' content and formatting. This option will also adjust the column width for the 
column the destination cells are in to match the column width of the copied cell.

Transpose All of the contents and formatting from a group of copied cells. This option will also switch rows to 
columns and vice versa.

Values Just the values from the copied cells without formulas or formatting.

Values & Number Formatting Just the values and any number formatting from the copied cells without formulas or other types of 
applied formatting.

Values & Source Formatting Just the values and any applied formatting from the source cells without the formulas.
Formatting Just the formatting from the copied cells without any cell content.

Paste Link
The content from the selected cells into the new cells and will create a link between the cells. If you 
make any changes to the copied cells, those changes will be reflected in the new cells. This option works 
only for certain types of content, such as formulas that contain absolute references.

Picture The displayed content from the copied cells as a picture. The pasted content will no longer behave like 
values, formulas, functions, text, and so on.

Linked Picture
The displayed content from the copied cells as a picture and create a link between the picture and the 
copied cells. The pasted content will no longer behave like values, formulas, functions, text, and so on, 
but changes made in the copied cells will be reflected in the pasted picture.



The Paste Special Dialog Box
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• Excel 2021 provides you with several other paste options that you can access by using 
the Paste Special dialog box. 

• You can access the Paste Special dialog box by selecting the drop-down arrow on the 
Paste button on the Home tab, and then selecting Paste Special.

Paste Special 
Option Description

Add Adds the value in the copied cell to the value entered 
in the destination cell.

Subtract Subtracts the value in the copied cell from the value 
entered in the destination cell. 

Multiply Multiplies the value in the destination cell by the 
value in the copied cell.

Divide Divides the value in the destination cell by the value 
in the copied cell.

Skip blanks
If the range you copy includes blank cells, these will 
be omitted when you paste the content to the 
destination range of cells.



Relative References
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• In Excel, there are three types of references: relative, absolute, and mixed.
• A relative reference is a cell or a range reference that will change when you move or 

copy a formula from one cell to another. In other words, the reference is relative to the 
location of the cell.

In this example, the formula from cell D1 has been copied and pasted into cell D2. The 
formula in cell D1 adds the values in cells A1, B1, and C1. So when you copy and paste 
the formula into cell D2, it still looks for the values in the cells three spaces to the left, 
two spaces to the left, and one space to the left. This is why the reference has changed 
from A1:C1 to A2:C2, as those are now the cells the correct number of spaces away 
from the formula. If you were to paste the same formula into cell D3, the range 
reference would change to A3:C3, and so on.



Absolute References
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Absolute references refer to particular cells and do not change when you move or copy 
formulas to other cells. In Excel, absolute references are indicated by using the dollar sign 
($) before the row and column header. So, if A1 is a relative reference, then $A$1 is an 
absolute reference.

In the following example, the cells in column D contain formulas with relative references. These 
were copied from cell D2 to the other cells in the column. By default, the cells in column D would 
display the sales totals for each sales rep for the first two quarters. The formulas in column E are 
multiplying the sales totals from column D by a fixed rate. In this case, it's the sales commission 
rate in cell G4. Because the formula in cell E2 contains an absolute reference to cell G4, when 
copied to cell E3, the formula still references the same cell. Notice, however, that the formula is 
referencing the sales total in cell D3, not D2, because that is a relative reference in the formula.



Mixed References
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Mixed references are cell or range references in which either the column or the row 
header is absolute, but the other reference is relative. The cell reference A$1 would be a 
mixed reference. In this example, the column header, A, is relative and will change if used 
in a formula that is copied or moved to another cell. But the row header, $1, 

In the following example, the worksheet contains a list of three products, each with their 
base price. Rows 6 and 7 show the percentages that the prices have been marked down 
for the last three years. Columns E through H will calculate the price for each product, for 
each year, after the markdown is applied. The basic formula that would go in cell F2 
would be: =B2*(1-B7). This multiplies the desktop's base price by its remaining 
percentage after the markdown is applied for the year 2013.

Presenter
Presentation Notes
As mentioned with mixed references, you can use the AutoFill feature to quickly and easily copy and paste a formula across columns and rows. This is one of the most useful features Excel has to offer.



Worksheet References
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Creating a reference to cells on another worksheet is as simple as adding the worksheet 
name and an exclamation point directly before the cell or range reference. Let's look at a 
simple example using the default worksheet names you would find in a new blank 
workbook. If you have a formula on Sheet1 and you would like that formula to reference 
cell D3 from the worksheet Sheet2, you would include the following reference in the 
formula: Sheet2!D3. Excel allows you to rename your worksheets, so be sure to include 
the correct worksheet name when creating references to cells on other worksheets.

You can also graphically select cells and ranges on other worksheets for use as references 
in formulas. You do the same as you would for references on the same worksheet, except 
you switch to the correct worksheet to select the cell or range.

Presenter
Presentation Notes
As mentioned with mixed references, you can use the AutoFill feature to quickly and easily copy and paste a formula across columns and rows. This is one of the most useful features Excel has to offer.



Excel Errors and Display Issues
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There are a number of common issues that can cause errors in Excel, each returning a 
unique error message. It is important to understand what causes these errors and how to 
resolve them.

A series of number signs indicates that a column is too narrow to display all cell content.



Error /
Display Issue What It Means What to Do

#####

The most common cause of this display issue, which is 
sometimes referred to as "railroad tracks," is that a 
column is too narrow to display all cell content.
You may also see this error if dates or times in your 
worksheets contain negative values.

Either adjust the column width to 
accommodate cell content or adjust your 
date or time entries to require fewer 
characters.

#VALUE!
An Excel formula has encountered an unexpected value 
(for example, text where it thinks numeric values should 
be).

Correct the data entry or the cell 
reference in the formula, or enter a 
different formula.

#DIV/0!
A formula you have entered is forcing Excel to divide a 
value by zero. This can happen either when zero is the 
value in the cell or a cell contains no value at all.

Correct the data entry or the cell 
reference in the formula, or enter a 
different formula.

#REF! This error indicates an invalid reference. One common 
cause is deleting a cell that a formula references.

Update the formula or restore the 
deleted cell.

#NULL! You have tried to reference the intersection of two ranges 
that do not actually intersect.

Correct the intersection reference.

Excel Errors and Display Issues
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The following table lists some of the common Excel error and display issue messages, 
what they mean, and possible solutions.



Excel Errors and Display Issues
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• One other common error indicator you'll encounter occasionally is a green triangle icon 
in the top-left corner of a cell. This indicates some other type of error involving 
formulas that still returns a valid value.

• When you select a cell containing an error indicator, Excel displays a drop-down menu. 
This menu indicates the type of error Excel flagged, provides you with access to 
options for correcting or ignoring the error, and provides access to Help resources 
about the particular error.

• Here, the user mistakenly multiplied a set of 
values instead of adding them, which doesn't 
match the surrounding data.
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